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1. Background

This document is intended to help the GPS user doing resource grade work become more acquainted
with the use of various types of GPS receivers, data collection standards and the creation of quality GIS
data.

For many people, using GPS equipment for mapping can be an efficient, yet accurate way to collect
information out in the field. It is often assumed that one can just pick up a unit and go collect. Since the
data exists electronically, there is a perception that it is easily transferred into the realm of GIS.
However, what most folks fail to realize is just how complex this technology can be as well as the time
involved converting GPS data into a quality GIS.

GPS is probably the most accurate tool for mapping, but it does contain some level of error. GPS data
collected with Trimble units and corrected under normal conditions with your average units will yield a
confidence of about 1 to 5 meters. Handheld Garmin units generally do not have differential correction
capability, with the exception of receivers that are DGPS and WAAS ready (see Section 2). Data
collection methods play a big part in the quality of mapped features. If a GPS unit is not set correctly in
accordance with the collection method, spikes/stray positions may occur with greater frequency. Also,
higher-end units tend to have the technology of increased filter capabilities that will provide for an even
better GPS/GIS output.

Poor data collection techniques and inherent errors like multipath can increase the need for editing the
collected data if it is to be used in GIS correctly, preferably by the GPS user who collected it in the field.
Editing in Pathfinder Office can minimize unnecessary work in the GIS.

There are a number of programs available to the GPS user. When working with Trimble units,
Pathfinder Office is usually used. There are several utilities for downloading Garmin data into Arcview
(the DNR Garmin Extension for Arcview being the best). GPS data can readily be exported into various
GIS formats. For the general user, the typical format is Arcview shapefile. Master datasets that may
reside in a GIS library on a network are generally stored as Geodatabases or ArcInfo coverages. GPS
coordinates stored in a textfile format can also be brought into GIS using ArcMap, ArcCatalog or
Arcview. It is possible to convert data without realizing that the wrong configuration settings were used.
Hopefully by adhering to the following procedures, many mistakes can be avoided.



2. GPS Receivers

There are a variety of GPS receivers available on the forest that can collect data, but it is important to
understand their capabilities and limitations. It is also important to keep your data needs (including type
of data) in mind when selecting a unit. Trimble units are specifically designed to collect and store spatial
information. Garmin units are primarily designed as a navigation tools. A lot can depend on what you
want to use the data for that may govern which GPS tool to use, but keep in mind the final product. GIS
uses the best data available (which may not be very good). Rule of thumb, Garbage In Garbage Out. In
collecting data, don't short yourself in getting the best data possible.

Currently, the San Juan GIS Team recommends the use of Trimble (or equivalent) GPS units for
data collection when units are available. These units provide a higher quality of data and interface
with GIS very well. However, it is understood that cost and availability can be a deterring factor and
more, less expensive Garmin handheld units are available to users on the forest. Any GPS data going
into GIS layers, regardless of source, should be as “clean” (edited) as possible.

GPS accuracy and data standards can vary between forests and agencies as well as be influenced by the
type of data being collected. Some national direction has been set for certain kinds of information. The
following is a brief list of some defined standards and accuracy requirements. Refer to Appendix B for
recommended settings on resource grade GPS data collection for the San Juan NF.

GPS Standards defined Various Accuracy Requirements
e GPS standard for GIS (draft) WO e NMAS 40ft (12.2m)
e FGDC part 3 Geospatial NSSDA 13.9m
Positioning Accuracy FGDC 10m

e FSH 2409.12 Timber cruise
Handbook

GPS design accuracy < 15m
LAAS, WAAS for
airport/aircraft requires 5
satellites.

A. GENERAL FEATURES

1. Trimble: 8-12 channel (including GeoXT, GeoXM, Geo Explorer 1,2,3, ProXL, ProXR,
Allegro Datalogger)

Cost: $$-$33
Accuracy:
a. Uncorrected data without Selective Availability: 5-15 meters.
b. Differential Correction (DGPS): 1-5 meters
c. Wide Area Augmentation System (WAAS) capable receivers: 1-3 meters
Refer to the document K:\res\gisteam\gps notes\waas_faq.pdf for a detailed
description of WAAS.
d. Carrier Phase: Submeter
Features:
a. Data Dictionary — to record attributes in greater detail. Can be designed to
match existing GIS layer attribute fields.
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Postprocessing — GPS files can be differentially corrected and edited.
Can average multiple positions per point to yield a more accurate point.
Memory storage — generally can accommodate large amounts of data.
Ideal for Point, Line and Polygon data.

Software Pathfinder Office (Active Sync/Lassen PC for the Allegro)

/oo

(¢

2. Garmin: 8-12 channel

Cost: $
Accuracy:
a. Uncorrected data without Selective Availability: 15 meters.
b. Garmin under trees 20-40m.
c. DGPS (must have beacon receiver, antenna and within range of a beacon
transmitter): 3-5 meters
d. Wide Area Augmentation System (WAAS) capable receivers: < 3 meters

WA AS-enabled products:

eTrex Legend GPEMAR 168 Zounder
elrex Wenture GPSMAP 17EM TEC
eTrex YWista GPEMAP 1382

Geko 201 GPSMAP 188 Sounder
GRS W GPShAP 196

GRS 15H and GPS 150 GPShAR 232

GPE 16 GPEMAP 238 Sounder
GRS AT GPSWAP 205

GPT T2 GPShAP 2006

GRS 76 GPSMWAP 2010

GPE 152 iGue 3600

GPEMAP TE Rino 110

GPSMAP TES Rino 120

GPSMAP 162

Features:
a. Designed and excellent for navigation.
b. Works very well with collecting points.
c. Small, lightweight.
Software: Several extensions available for downloading to Arcview (DNR is the best).
Line or Polygon data will require a lot of editing.

B. TRIMBLE GEOEXPLORER 3
Dan Greene — 10/19/2001, modified by Mark Roper 5/30/2002

Black On/Off key

Power down or on
Check Power and Memory (SYS KEY)

Other Keys

SYS — check for satellites, power, setup, coordinate system for navigation, etc
DATA — enter point, line or polygon data



LOG — pause or start logging data
NAYV - navigate to a known location
CLOSE - close a menu
OPTION - options off of sys, data or nav
FN with OPTION = more options
ARROWS —up, down, right, left for menus

Coordinate system for GPS Unit

Use Latitude/Longitude on Unit since easiest to reference maps. It does not matter what the
coordinate system is on the GPS since you convert it to what you want using the export function
in Pathfinder Office.

LATITUDE
DATUM WGS 1984
ALT REF MSL
ALT UNITS FEET

If you choose to use UTM rather than latitude and longitude, refer to Appendix B.
Satellites

SYS key — tracking for GPS when solid black fill. This is dependant on the GPS setting of
PDOP and SNR best set with the bar graph. The higher the PDOP number the worse the

spatial accuracy. When changing settings on the bar, you can see that PDOP and SNR are
related and both change. Region 2 standards recommend a PDOP of 6 or less, but that is not
always possible. If this accuracy is not obtainable, any adjust should be documented. The
message on the screen will let you know if there are not enough satellites based on your settings.
Preplanning is a good way to determine when the optimum time to collect will occur based on
Specified settings.

SYS Function Key

FN OPTION for main menu (setup, config)

DATA
Log between features OFF
Log PPRT data NO
Log velocities NO
Antenna height 1 meter or 3.28 feet (about waist high)
Allow GPS update NO
Warning distance N/A
Filename prefix R (default is R but you could set to your initials)

UNITS
Set the Units to what is practical for finding your way around on the ground.
These are not related to what you will export for GIS.
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Distance Feet

Area Acres

Velocity Feet/Second

Angle Degrees

North Reference True

Declination Auto (the unit figures it out)

GPS

PDOP Mask 6.0 using the custom settings. However if you can’t get
Satellites you may need to use a higher number. 6 is a good starting
point but you can change it on the fly. If the recorder stops reading
you can keep it on the GPS screen and lower or raise as you are
recording data

SNR Mask 6.0 using the custom setting. This dictates that a satellite’s signal
will not be used if less than 6.0.

Elev Mask 15 degrees or default with sliding bar

Min Satellites 4

COORDINATES
See above recommendation for Latitude/Longitude
Refer to the Export Settings for UTM recommendations.

FORMAT
Language English
Offset Horz/Verticle
Degrees DD MM SS
Time 24 hr
Time Zone (-7 without daylight savings, -6 daylight savings)
7 hours less than Greenwich time
Coordinate Order Lat/Long

DATA Function Key
This is for entering new data. Before entering data check to see if you have enough satellites.

Files are used to store data sets. A set of GPS data is a collection of lines, points and polygons
(areas). You may use the LOG key to switch between points or different features. As an
alternative, you may use different files for different feature types.

Delete Files (All files are retained unless you specifically delete them)
Option, Delete Files

Create New File
Point
Line
Area



The point, line and area are default types. If you use the data dictionary (preferably using
Pathfinder Office, then you can establish your own feature types that also have data collection
fields. This is very easy to do and when done you can easily upload the files from the PC to the
hand held unit. See the video on CD for an excellent tutorial on how to do this. Data
dictionaries should be set up before going to the field.

G. ALLEGRO DATALOGGER
Sally Zwisler — 5/13/2002

Documents on the use of the Allegro Datalogger and Trimble GPS receiver have been prepared
by Sally Zwisler and can be found on the server at:

K:\unit\res\gisteam\gps_notes\allegro_user_notes.doc
K:\unit\res\gisteam\gps_notes\allegro_wypts_process.doc

The following may be included in a later version

TEED O

TRIMBLE GEOEXPLORER 2

TRIMBLE PROXR WITH TSC1 DATALOGGER
TRIMBLE PROXL WITH TDC1 DATALOGGER
TRIMBLE PROXR WITH MC-V DATALOGGER
. GARMIN

3. Data Transfer

A. Using Pathfinder Software on the PC for Trimble Units

Data transfer of Trimble GPS files can be accomplished by running the Data Transfer program
from within Pathfinder Office or by using the stand-alone program found in Start - Program
Files > GPS Pathfinder Office > Data Transfer.
To transfer GPS Rover files to the PC:
1. Select Utilities = Data Transfer.
2. The program will try to automatically connect with the unit. Depending on the GPS
receiver, it may be necessary to select to proper device.
NOTE: If transferring data from a Geo 3 using the serial clip instead of the support
module, the Geo 3 communications must be set to reflect this. In the unit, SYS =>
Setup tab > COMMS > Data Transfer: Serial clip.
3. click Add = Data File (for GPS Rover files).
4. Highlight desired files and click Open.
5. click Transfer All.

This method is also used to transfer Data Dictionaries, Waypoints, Configuration files, etc. to
and from the GPS receiver. Simply select the desired file type using the Add button and the
directionality tab Send/Receive.



B. Using the DNR Extension for Arcview for Garmin units

DISCLAIMER: It is not recommended that Garmin data be used as a substitute for
resource grade GPS work for inclusion into the corporate GIS. The quality of Garmin
data is generally not at the same level as Trimble (or equivelant) units.

Data transfer of waypoints and tracks from a Garmin hand-held unit can be accomplished
through the use of the DNR Garmin Extension for Arcview. This is a free downloadable

program available at the following address.

http://www.dnr.state.mn.us/mis/gis/tools/Arcview/extensions/DNR Garmin/DNRGarmin.html

To use the extension:
a. Connect the Garmin unit to the PC via a download cable.
b. In Arcview, activate the extension by selecting File = Extensions = DNR Garmin-
Arcview.
c. In the main menu, select DNR Garmin = Open Garmin GPS. This will open a
separate program that will automatically connect to the unit to Arcview.
d. Download POINTS
i. select Waypoint 2> Download.
ii. select File = Save As = Arcview Shapefile.
iii. select New (or Append) > name of shapefile.
e. Download LINES or AREAS
i. select Track = Download.
ii. select File > Save As = Arcview Shapefile = Point/Line/Poly.
iii. give a new name for the shapefile.

See Section 8 for uploading GIS data to a Garmin using this extension.
C. Using the Allegro Datalogger
Refer to the document prepared by Sally Zwisler.

K:\unit\res\gisteam\gps_notes\allegro _user_notes.doc

4. Differential Correction (for Trimble units only)

Differential Correction of GPS files can be accomplished by running the Differential Correction
program from within Pathfinder Office or by using the stand-alone program found in Start = Program
Files > GPS Pathfinder Office > Differential Correction. To correct GPS Rover files:

A. Select Utilities > Differential Correction.

B. Recently download files will be visible in the window. If the desired files are not, select the files to
be corrected by clicking on Browse, navigate to the proper location, highlight and click Open.



C. The following is the primary method of retrieving files off of the Internet for use within Pathfinder.

NOTE: Pathfinder Office can use compressed and RINEX formats as is. There is no need to convert
files. If needed, see Appendix D for instructions on using FTP to download base files.

1. After selecting the Rover files to be corrected in the Differential Correction window, click
Internet Search to bring up Internet Search window.

2. Select the desired Base Data Provider from the pull down menu and click OK. Skip to 5.
(For San Juan Public Lands users, refer to the Base Station Map in Appendix A.)
Base files are good to within 500 kilometers (310 miles).

. If the desired base stations are not visible in the window, click New.

4. Selecting a provider:

a. If you have never copied provider list from Trimble:
1. Select copy most up-to-date list and click OK.
2. Click Yes.
3. Select provider and click OK.
b. If you have current provider list:
1. Select from current list and click OK.
2. Select provider and click OK.

5. Click Yes. The program begins downloading base files to the directory you have set up for

the project.

6. Click OK.

7. Click OK. The files will now be visible in the base file window.

(98]

5. Editing in Pathfinder Office (Trimble units only)

A. Edit GPS files in Pathfinder Office to eliminate unwanted features and positions (vertices) first by
removing spikes, position strays and other errors in features.
1. To eliminate a feature:

a. Right-click on the feature > Delete > Yes.

b. Not In Feature positions will be visible where the delete position was. Remove these
if desired by using the Delete Block tool on the tool bar. It is recommended that
any feature layers be turned off before using this tool or you might delete additional
positions.

2. To eliminate unwanted positions:

a. Right-click on the position (vertex) to be deleted and select Delete Position. To

remove a group of positions, use the Delete Block tool.

b. Save often. This will minimize the need to edit these errors in GIS making the data a

little easier to manage.

c. A deleted position or feature can be undeleted if needed.

B. Visually check the data to ensure it represents what was mapped in the field as much a possible. Any
major discrepancies should be documented. The intent is to have a file as clean as possible prior to being
loaded into a GIS.
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6. Exporting with Pathfinder Office

If your intent is to gather GIS data, setting up your export properly is one of the most important
things to do. You can control the resulting GIS projection from the export regardless of what
projection was used on the handheld unit. If the export projection does not match the GIS (UTM
Zone 13 North, NAD27, for Region 2), then the data will not be located in the right part of the world.

A. Open the Export Utility in Pathfinder Office by selecting Utilities > Export from the main menu.
This will open the Export window.

B. Select the file(s) to export by using the Browse button.

C. If needed, select the Output Folder by using the Browse button. The Output Folder is the
destination of where you want the exported files to go. This folder typically has been setup during the
project selection at the Pathfinder Office startup.

D. Choose an Export Format: Arcview Shapefile (preferred), ArcInfo or ASCIL

(It is highly recommended that copies of these formats be used instead of the samples. Make a copy of a
setup using New Setup.)

E. Set the export settings to the Region 2 standard by clicking Properties.

Coordinate System
1. Check Use Export Properties and click Change

a. System: UTM
Zone: 13 North
Datum: NADCON (Conus)
Units: Meters

b. If using Altitude reference (relevant for xyz in DEM creation), set to MSL,
Other = Geo0id99 (Conus)
NOTE: NADCON (Conus) is to be used when converting GPS (WGS84/NADS3) data to the NAD27
datum. DO NOT use the NAD27 (Conus) setting as it does not use the correct transformation algorithm.
NADCON (Conus) is the Federally accepted conversion program.

Position Filter
1. Minimum Satellites set to 3D (4 or more SVs)
2. Maximum PDOP set to ALL. (PDOP standard is 6 and should be set in the unit.
Sometimes this number is adjusted by the user if satellite acquisition is difficult.)
3. Everything except UNCORRECTED is checked as default. If you process
uncorrected data, then check uncorrected.

Units
Check Use Export Units. Set to Meters, square meters and meters per Second.

Attributes (personal preference)
1. Date Recorded
2. Datafile Name

3. PDOP
11



4. Receiver Type

Output
1. Combine all input files and output to the export is checked.

2. Leave as windows files.

F. Once the options have been set, click OK. The settings for these formats will remain saved unless
manually changed by another user. On PCs with multiple user profiles, these setting may differ from
profile to profile. It is recommended to confirm the settings prior to running the export utility.

G. Check to ensure the correct settings appear under the Export Setup. Click OK to export. The
message box should say X# features exported.

NOTE: Ifyou inadvertently select points on the GPS unit when you intended to collect lines, you can
choose to export each individual GPS reading.

G. Read Export Completed window to check for a successful export. If there is an error in the export
process review the log file by clicking on More Details. A common error results from trying to export
files with mismatched data dictionaries. To resolve this, export the files with different dictionaries
separately.

H. Click Close. Depending on how many exports are performed, it may be necessary to put files into
multiple folders to avoid overwriting files. Export creates files based on feature name.

Tech Tips: 1) you can export multiple files together. 2) you can continue the ID increment from the
previous session. 3) files with different data dictionaries may need to be exported separately or export
may give an error.

7. Converting GPS into GIS Data

What next?

Now that the export has been completed, is the data GIS ready? In Section 6, if the GPS data was
exported using the Arcview Shapefile format, the data is ready to be used in ArcMap or Arcview but

may still require further editing. If the data was exported using ArcInfo or ASCII formats, then some
additional steps are necessary.

I. Arcview Shapefiles

File Extension File Type Feature

.shp spatial version 2 format

.shx index version 2 format

.dbf attributes  version 2 format

anf log export file

.prj projection  created projection is defined for the feature in ArcCatalog/ArcMap
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Shapefiles have been created if the Arcview format was used. The data is ready to be used immediately.
If the data needs to be converted into something else (coverage or geodatabase), there are several
methods that can accomplish this in ArcGIS.

A. ArcCatalog
1. Start > Programs 2> ArcGIS > ArcCatalog

2. Right-click on the shapefile and choose Export 2 Shapefile to Geodatabase (or Coverage).
Select the location of where you want the file to go.

B. ArcToolbox (convert multiple files at a time)

Start = Programs = ArcGIS = ArcToolbox

Set Tools > Options > Precision > Double

Expand Conversion Tools

Expand Export from Shapefile

Select Shapefile to Geodatabase or Coverage and select where you what the file to go.

MRS

C. Arclnfo PC/UNIX (coverages)
1. Ensure the Arc environment is set to precision double double, if needed type this on the
command line. Anything else will incur arc or polygon movement within the coverage.
SINGLE precision covers have a much higher tolerance default value than DOUBLE. This
gives arcs and polys greater freedom to move around creating potential accuracy problems.

2. Convert shapefile into a coverage.
Arc: shapearc <shapefile> <cover> <subclass>
(i.e. Arc: shapearc camps.shp fs_camps poly)

NOTE: Subclass should be used if converting area data into a polygon coverage. This will create
regions containing the area attribute data. If no subclass is used, the attributes will be attached to the
arcs, not the polygons.

3. Redefine tolerances of the new coverage.
Arc: tolerance <cover> <type> <value>

The <type> is the tolerance to define and <value> is the value of the tolerance.
The following is a list of suggested values. Depending on the data, it may be necessary to adjust
these values.
Type Value
weed 0
grain 1
node 1
snap 1

4. The cover will then need to be cleaned to remove intersect errors involving line and area
coverages. Polygon features are converted into Regions so overlapping polys are allowed.

Arc: clean <old_cover> <new_cover> 0.0000001 0.0000001 {line|poly}
(i.e. Arc: clean fs_camps fs_camps2 0.0000001 0.0000001 poly)
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Use regionpoly if polygon topology is needed. This converts regions into a separate polygon
coverage.

Arc: regionpoly <in_cover> <out_cover> <in_subclass> <out_table>
(i.e. Arc: regionpoly fs_camps2 fs_camps3 poly polytable)

5. Kill unnecessary covers using:
Arc: kill <cover> all
6. Rename coverages as needed.

Arc: rename <old cover> <new_cover>

Tech Tips: 1) shapefiles can be spatially edited within ArcMap or Arcview. 2) you can combine/merge
multiple shapefiles into a single shapefile using the geoprocessing extension.

II. ASCII

File Extension File Type Feature

.pos coordinates point, line, poly

.att attribute point, line, poly

.aa attributes (created by export if set to one set of files per feature)
.CSV comma-delimited (created by export if set to one set of files per feature)
Anf log export file

Axt text

.dbf Dbase

Tables containing XY positions and attributes can be converted into point feature classes a couple of
different ways using ArcCatalog and ArcMap. Common files ArcMap can use are TXT, DBF and CSV.

A. ArcCatalog

1. Open ArcCatalog and find the table containing the coordinates.
2. Right-click on the table and select Create Feature Class = From XY Table.
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Create Feature Class Fron

—Input Fields
 Field:
[EAsTING |
v Field
[NORTHING =
Z Field:
|<N0ne> j

Spatial Reference of Input Coordinates |

—Cutput

Specifty output shapefile or feature class:
- = pecify outp p

Copy CirHC IC'\gls\temp\my_sample el vy
. Delete

Fename Fz ConfiguratiEn kesaard
Export » | ﬂ

Create Feature Class id ¢ From Route Event Tahle.. Arbvanced Geometry Options |

@
A Lotus &5 Geocode Addresses...

=S

) r oK | Cancel |
2 a feat Froperties ates in a table

Select the fields that contain the X and Y data (i.e. Easting and Northing).

Specify an output location, be it a shapefile or within a geodatabase.

SNk w

are different that the desired coordinates (i.e. State Plane to UTM).

Select Spatial Reference of Input Coordinates and set the native projection of the coordinates.

If necessary, set the output projection in Advanced Geometry Options if the native coordinates

7. Click OK. The new feature class (including attributes) has been created and can be added as a

layer in ArcMap.

B. ArcMap
Select Tools = Add XY Data.

Select a table from the dataframe or browse for the file.
Select the fields that contain the X and Y data (i.e. Easting and Northing).

M

saved as a Layer File or exported as a feature class.

C. Arclnfo for PC/UNIX

Select Spatial Reference of Input Coordinates and set the native projection of the coordinates.
Click OK. There is now a new event layer derived from the table in the dataframe. This can be

The only reason to use this export type is if substantial editing to the attribute table is needed. Even so,
the ArcInfo format can also accommodate this need as the .aa, .pa and .gen files are essentially comma-
delimited (.csv) which can be opened in most spreadsheets. Covers can also be generated from ASCII

files that were produced in a spreadsheet providing the files are saved in comma-delimited format.

1. Copy or move files into workspace.

2. Using any of the sample AML’s as a guide (see Appendix G), insert the proper names for the
files requested. When defining the attribute file, enter the field names that correspond with the
data's attributes. DO NOT use the fields listed in the samples as a default. They are only intended

to be used as a guide. Save the file when through editing the AML.
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3. Files created or saved in .csv format (not the .aa or .pa) contain carriage returns that must be
removed before the AML is run. Edit the files using VI editor in Unix.

> vi <filename>
:g/[entrl]v[entrlJm/s///
:wq (this saves the file and exists VI editor)

4. END (uppercase letters) must be added at the end of coordinate files. (In an arc or poly file,
there will actually be two END’s at the bottom of the file.) Save files when finished and Close.
5. Run AML

Arc: &r <aml file>

8. Converting GIS Data into GPS for Use in the Field.

Sometimes it is useful to take GIS data back out into the field. Uploading GIS data is a similar process
as downloading since the data transfer tools are used here also.

A. Using Pathfinder Software on the PC for Trimble Units

1. GIS data should be in Shapefile format prior to importing.

2. In Pathfinder Office, select from the main menu Utilities 2> Import.
3. Click Browse to locate and select the file to import.
4
5

Select the Import Setup for Arcview Shapefile (recommend make a copy and edit the copy).
Set coordinate system properties if necessary.
System: UTM
Zone: 13 North
Datum: NADCON(Conus)
Units: Meters
6. Click OK. The file created will have an .imp extension. This can now be transferred using
Data Transfer.
Select Utilities = Data Transfer.
Once connected, select the Send tab to transfer the file to the GPS unit.
. Click Add - Data File.
10. Highlight desired files and click Open.
11. Click Transfer All.

0 %0 N

B. Using the DNR Extension for Arcview for Garmin units

To use the extension:

1. Connect the Garmin unit to the PC via a download cable.
2. In Arcview, activate the extension by selecting File = Extensions = DNR Garmin-Arcview.
3. In the main menu, select DNR Garmin = Open Garmin GPS. This will open a separate
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program that will automatically connect to the unit to Arcview.
a. Upload POINTS
i. Select File > Load > Waypoint from = Active Theme. Make sure the
theme containing the points to be transferred is active in the view window.
ii. Select a unique field (ex. ID) that is a number or text.
iii.  Select a comment text field, usually a description or name of the point. Click
OK. DNR will read loaded X# of waypoints at the bottom of the window.
iv. Select Waypoint > Upload. This will transfer the points to the Garmin.
v. Click OK.
b. Upload LINES or AREAS
i. Select File > Load = Track from = Active Theme. Make sure the theme
containing the points to be transferred is active in the view window.
ii. Select a unique field (ex. ID) that is a number or text.
iii.  Select a comment text field, usually a description or name of the point. Click
OK. DNR will read loaded X# at the bottom of the window.
iv. Select Track = Upload. This will transfer the points to the Garmin.
v. Click OK.

C. Uploading Waypoints to the Allegro for Navigation.
Refer to the document prepared by Sally Zwisler.

K:\unit\res\gisteam\gps_notes\allegro_wypts_process.doc
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Appendix

A. Base Station Map

The base station map can be found on the server at the following address. Click on the address to open
the file.

K:\unit\res\gis_team\gps_notes\base station.jpg

B. Key Settings

GPS
PDOP Mask -- 6.0 (using the custom setting) Recommended
NOTE: Ifyou can’t get satellites, you may need to use a higher number.
SNR Mask  -- 6.0 (using the custom setting) This dictates that a satellite’s signal
will not be used if less than 6.0.
Elev Mask  -- 15 degrees
Min Satellites -- 4 (unit will collect in 3D mode)

Export Coordinate System

System --UTM

Zone -- 13 North

Datum -- NADCON (Conus)
Units -- Meters

Altitude -- MSL

NOTE: NADCON (Conus) is to be used when converting GPS (WGS84/NADS83) data to the NAD27
datum. DO NOT use the NAD27 (Conus) setting as it does not use the correct transformation algorithm.
NADCON (Conus) is the Federally accepted conversion program.

Export Units
Distance -- Meters
Area -- Square Meters
Velocity -- Meters per Second

C. Commands

Windows commands:
copy -- copy file(s) to a destination.
del  -- deletes file(s).

dir  -- lists the contents of a directory.
move -- moves file(s) to a different location.
ren -- rename file(s)

cd -- change directory.
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md  -- creates a directory.

rd -- removes a directory.
UNIX commands:
I —list long (lists files in a directory including date and file size.)
Is  —list short (lists files in a directory, name only.)
pwd — lists current directory.
cd — changes directories.
ARC commands:
Ic - list cover (lists coverages in a workspace.)

kill — removes coverages from workspace.

copy — copies coverages from one location to another.

cw -- creates a workspace.

q -- quits ArcInfo

<> -- items in <> define the names of files/folder or options the user needs to use in
association with ARC commands.

D. Using FTP to Download Basefiles

1. Before selecting Rover files to be corrected you will have to download to necessary base files.

2. You must know the timeframe in UTC (Greenwich, England) your rover files cover in order
to retrieve the appropriate base files. Mountain Daylight Time is UTC minus 6 hours
Mountain Standard Time is UTC minus 7 hours.

3. For Windows 2000 Open the FTP Hummingbird Window.

Click Start - Programs > Hummingbird Connectivity v7.1 = Exceed - Host
Explorer > FTP for Windows Explorer

4. Double-click on New FTP Profile to open FTP Site Properties Window.

a. Enter Host Address -- ftp.compasscom.com (check base station web pages for other
examples.)

b. Enter User Name — check the anonymous box.

c. Enter Password — typically autogenerated with the user’s e-mail address or use ftp.

d. Enter Initial Dir [optional]

e. Click Ok

f. This creates an icon for that FTP site. Double-click on newly created icon to connect to
the site.

5. Navigate to the desired directory and identify the correct base files.

6. There are now two windows open showing a filing structure. One is the server that you just
connected to and the other is the C drive of your network PC. It is recommended that base
files be put on the C drive in a common base folder directory. Navigate to the appropriate
directory on the C drive.

7. Highlight the appropriate files of the internet server with the mouse and/or keyboard. Be sure
to retrieve enough base files to cover your rover files.

8. With the files highlighted, right mouse click = Copy.

9. Open the base folder on the PC and right mouse click - Paste.

10. When finished with the FTP, click File and Exit.

11. Proceed with the correction process as described in Section 4 of this document.
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E. More Tech Tips

1.

Areas can have labelpoints occur outside of their perimeter that can cause attributes to be
dropped when generating a coverage. In ArcInfo, overlapping Areas will create new
polygons without attributes and labelpoints.

Labelpoints are necessary for Areas if attributes are to be appended from the attribute table.
Lines and Areas need editing to remove spikes and squiggles as much as possible before
they are made into coverages.

Depending on the types of Line features (roads, streams, etc.), they will need to be snapped
(connected) together to form continuous data.

Length, perimeter and area values may differ in GIS vs. the original (edited) GPS corrected
file. Any editing done in GIS will alter the values further.

Arc may not allow the use of comma-delimited files with uppercase file extensions.
Exporting files together with different data dictionaries will cause Pathfinder Office’s
Export Utility to stop and will require files containing such to be exported separately.
Comma-delimited files sometimes have hidden carriage returns within the file that must be
removed using the VI editor in UNIX for use in AML'’s.

F. Converting GPS using ArcInfo for Unix

File Extension File Type Feature

.gen
.pa
.aa
.aml
.pts
Anf

coordinates line, area
attributes  point, area
attributes line

batch file point, line, area
coordinates point, area

log export file

1. For Windows 2000 Open a AIX Terminal (Xsession) window in Exceed either by clicking on
the AIX Terminal icon on the or by going to:

a. Start 2 Programs - Hummingbird Connectivity v7.0 > Exceed - Xsession
b. Highlight xstart aixterm window and select Run!

2. Enter username and password.

3. At the command prompt, navigate to the path (directory structure) where the exported GPS
files are to be located.

4. At the command prompt in the AIX window, type arc to run Arclnfo.

5. For working with files and coverages, a workspace will need to be created at the ARC prompt
if one does not exist already. A workspace is a directory that contains coverages, an INFO
subdirectory and other related ARC files. Additional directories or workspaces can be added
underneath the original workspace.

Arc: ew <workspace>
(i.e. Arc: cw gps_data)
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6. Move or copy files from the PC to the desired workspace using Windows Explorer. Double
check to make sure filenames are in lower case letters.

7. Before creating covers, the AML file for each feature must be modified:
a. Open Windows Explorer and find the AML for the feature located in the workspace
on the server.
b. Right mouse click > Open With - sclect WordPad.
c. edit AML file to include the path (location) of the attribute file after ADD
FROM. For area amls, the clean tolerances need to be changed from
# to 0.00000001. (see sample Area AML)
(i.e. ADDFROM /fsfiles/office/so/recreation/gps_data/camps.aml)
d. Click Save and Close.
e. edit .pts file for area covers (polygons) if needed to correct mislocated label
points. The label point is based on the centroid of the entire feature and that
point may lie outside of the area. Labels outside of the area will result in the
attributes not being appended to the polygon attribute table. In other words,
certain polygons will lack attributes. To correct: pick any coordinate that is
within the area and change the bad coordinate in the .pts file using the
corresponding ID number as a reference. (i.e. 1, 456211.002, 4865222.921. The
1 is the ID.) Save and Close file.
f. Repeat the process for each feature.

8. Run the corrected AML at the ARC prompt to create cover.

Arc: &r <aml file>
(i.e. Arc: &r camps.aml)

9. Rename the coverage. Use ¢ to list available coverages if needed.

Arc: rename <old cover> <new_cover>
(i.e. Arc: rename camps fs_camps)

NOTE: Coverage names should not start with a number, be no longer than 13 characters and do
not have spaces within the name.

10. Overlapping Polygons
If overlap polygons occur, a new polygon is created void of attributes and labelpoints.
This will make it necessary to either:
a. edit polygons in Pathfinder Office so no overlaps occur.
or
b. add new fields to the attribute table, re-enter the missing attributes and create
labelpoints for the new polygons.
NOTE: For the addition of new fields and labelpoints, consult your GIS specialist. It may be
necessary to use regions if overlaps are present.

11. If necessary, combine multiple covers of like features into one coverage by using the append
command (or consult your GIS specialist). This command requires that the covers being merged
have identical attribute fields. If they don't, these fields must be edited or append will not work.
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Arc: append <out_cover> <point | line | poly>

12. If errors occur at any time during METHOD I (Arc bailing out of the AML for example), it
will be necessary to kill the attempted coverage. This command is also used for removing older
covers.

Arc: Kill <cover> all

13. Sometimes corrupted covers and/or files cannot be removed with kill or delete. To
remove these, quit Arc and use the following:

:rm -R <file>

14. Proceed to further fine-tune and edit the new coverage within ArcInfo software (Arcedit,
ArcTools, ArcMap). This procedure may need to be done by a GIS specialist.

Tech Tip: Never drag and drop coverages. Always copy a coverage when moving it to a different
destination by using the copy command in Arc or by copying it in ArcCatalog.

G. Sample Area AML

Use uppercase letters. Field names for attributes following DEFINE are generated from the data
dictionary and export settings and will vary between projects. The fields listed are examples only.

GENERATE <cover>

INPUT <coordinate arc file>
LINE

INPUT <coordinate point file>
POINT

QUIT

CLEAN <cover> <cover> 0.0000001 0.0000001 POLY

&DATA ARC INFO

ARC

DEFINE <attribute file>
<cover>-1D, 5, 5,1
SITE-NAME, 18, 18, C
WEED-SPECIES, 20, 20, C
SITE-DESCRPT, 20, 20, C
DENSITY, 20, 20, C
MGT-RESTRICTIONS, 20, 20, C
CANOPY, 20, 20, C
MAX-PDOP, 8, 5, F, 1
RCVR-TYPE, 36, 36, C
GPS DATE,§,8,D
FEAT-NAME, 20, 20, C
DATAFILE, 20, 20, C
UNFILT-POS, 10, 10, I

ADD FROM /<path>/<attribute file>

Q STOP
&END
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JOINITEM <cover>.PAT <attribute file> <cover>.PAT <cover>-ID <cover>-ID

Sample Line AML (use uppercase letters) Field names for attributes following DEFINE are generated
from the data dictionary and export settings and will vary between projects. The fields listed are
examples only.

GENERATE <cover>
INPUT <coordinate arc file>
LINE

QUIT

BUILD <cover> LINE

&DATA ARC INFO
ARC

DEFINE <attribute file>
<cover>-ID, S, 5,1
DATE, 8, 8,D
SRC-CODE, 1, 1,1
TEXT, 30, 30, C
NUMBER, 4, 4,1
COMMENT, 30, 30, C
MAX-PDOP, 8§, 5,F, 1
RCVR-TYPE, 36, 3
GPS DATE, 8, 8,D
DATAFILE, 20, 20, C
UNFILT-POS, 10, 10, I

>

,C

ADD FROM /<path>/<attribute file>
Q STOP
&END

JOINITEM <cover>.AAT <attribute file> <cover>.AAT <cover>-ID <cover>-ID

Sample Point AML (use uppercase letters) Field names for attributes following DEFINE are generated
from the data dictionary and export settings and will vary between projects. The fields listed are
examples only.

GENERATE <cover>

INPUT <coordinate point file>
POINT

QUIT

BUILD <cover> POINT

&DATA ARC INFO
ARC
DEFINE <attribute file>
<cover>-ID, 5, 5, 1
DATE, 8, 8,D
SRC-CODE, 1, 1,1
TEXT, 30, 30, C
NUMBER, 4, 4, 1
COMMENT, 30, 30, C
MAX PDOP, 8§, 5,F, 1
RCVR-TYPE, 36,36,C
23



GPS-DATE, 8§, §,D
DATAFILE, 20, 20, C
UNFILT-POS, 10, 10,1

ADD FROM /<path>/<attribute file>
Q STOP
&END

JOINITEM <cover>.PAT <attribute file> <cover>.PAT <cover>-ID <cover>-ID

24



